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True/False

_____ A standard style of writing should be followed whether the document is an academic report or business report.

_____ Although the differences among styles appear in the manner of presenting the information, each style of documentation requires the same basic information.

_____ With the MLA style of documentation, a page number is placed at the left margin of each page, one-half inch from the top margin.

_____ In the MLA style, the title of the paper is centered one double-space below the writer's name and course information.

_____ In the MLA style, footnotes are used only for explanatory notes.

_____ Explanatory notes may be placed either at the bottom of the page as footnotes or at the end of the paper as endnotes.

_____ The MLA documentation style requires 1.5-inch top and bottom margins, and 1-inch left and right margins.

_____ Margins can be changed in the Margin Set dialog box.

_____ New margin settings take effect immediately in a document.

_____ When a graphic, or the top of a character, is chopped off, it is because the line spacing is set to At least and Exactly.

_____ Word, by default, single-spaces between lines of text and automatically adjusts line height to accommodate various font sizes and graphics.

_____ The MLA document style requires that one blank line should display between each line of text.

_____ The end mark is positioned one blank line above the insertion point when line spacing is double.

_____ With Multiple line spacing, a value is entered which represents a percentage by which Word should increase or decrease the line spacing.

_____ In Word, pages easily can be numbered by clicking Format on the menu bar and then clicking Page Numbers.

_____ A writer's name can be placed in front of the page number, as required by the MLA style, using the Page Numbers command on the Insert menu.

_____ In Word, headers are printed at the top margin one-half inch from the top of every page.
_____ Double-clicking between two buttons or boxes on a docked toolbar will cause it to float in its original floating position.

_____ The Header and Footer command displays on the Insert menu.

_____ Headers and footers do not display on the screen when the document window is in normal view because they tend to clutter the screen.

_____ Click and Type is available in normal view, in a numbered or bulleted list, and in a document formatted into multiple columns.

_____ First-line indent is a character format.

_____ It is possible to add your own entries to a list of AutoCorrect entries.

_____ An option found on the AutoCorrect sheet is Correct TWo INitial CApitals.

_____ The use of in-text parenthetical citations is suggested by the MLA guidelines, while the APA guidelines suggest footnoting each source of material in a paper.

_____ Character formatting such as the font and font size, and paragraph formatting such as line spacing and text alignment are the formats defined by a style.

_____ By changing the formatting associated with the Footnote Text style, every footnote entered will use the formats defined in this style.

_____ When Word closes the note pane and returns to the document, the note text remains on the screen in normal view.

_____ When notes are moved or deleted, Word automatically renumbers any remaining notes in the correct sequence.

_____ To verify if note text is positioned correctly on a page, you must switch to normal view or display the document in print preview.

_____ Word adjusts the position of automatic page breaks if text is added, deleted, or modified.

_____ In page layout view, automatic page breaks display on the Word screen as a single dotted horizontal line.

_____ Keep lines together and Keep with next are options found on the Line and Page Breaks sheet in the Paragraph dialog box.

_____ In a works cited page, the lines of each entry begin at the left margin.

_____ Word never moves or adjusts automatic page breaks.

_____ When manual page breaks are inserted, Word adjusts any automatic page breaks that follow in the document.

_____ Word inserts manual page breaks just after the insertion point.

_____ CTRL+ENTER instructs Word to insert an automatic page break below the insertion point, and position the insertion point immediately above the automatic page break.

_____ To properly center the titles of a works cited page, the First Line Indent marker must be moved back to the right margin before clicking the Center button.

_____ To drag both the First Line Indent and Hanging Indent markers together, the Left Indent marker is dragged on the ruler.

_____ It is not necessary to be connected to the Internet when creating a hyperlink in a Word document.

_____ To create a hyperlink, simply type the address of the file or Web page, and Word automatically formats it as a hyperlink.

_____ MLA style requires that works cited be listed in alphabetical order by author's last name.

_____ If the first character of the paragraphs to be sorted contains a mixture of letters, numbers, and dates, then the letters appear first and the numbers appear last when the paragraphs are sorted.

_____ You can go directly to a specific location in a Word document by using the Select Location button on the vertical scroll bar.

_____ Word's find and replace feature will locate each occurrence of a specified word or phrase automatically and then replace it with specified text.

_____ To replace text in a document with new text, click the Find and Replace button on the Standard toolbar.

_____ To replace only certain occurrences of the text, click the Find Next button in the Find and Replace dialog box.

_____ If the SHIFT key is held while dragging a selected item, Word copies the item instead of moving it.

_____ Note text cannot be included in the document statistics presented in the Word Count dialog box.

Fill in the Blanks

A popular documentation style used today for research papers in the humanities is presented by the __________.

In the MLA style, in-text __________ are used instead of footnoting each source.

In the body of a paper, raised numbers, or __________, are used to signal that an explanatory note exists.
_____ __________ are used to elaborate on points discussed in the body of the paper and may be placed either at the bottom of the page or at the end of the paper.

With the MLA style, the __________ page alphabetically lists works that are referenced directly in the paper by each author's last name, or, if the author's name is not available, by the title of the work.

According to the MLA style, __________ is(are) optional.

The MLA style requires that the writer's name and course information be placed in a block at the __________ from the top of the first page of the research paper.

Word is preset to use __________ margins.

To change the default margin settings, click File on the menu bar and then click the __________ command.

When using the MLA style, __________ can include text and graphics, as well as the page number, total number of pages, current date, and current time.

__________ can be used, when in print layout view, to format and enter text, graphics, and other items, by double-clicking a blank area of the document window.

Insert Number of Pages, Insert Time, Insert Page Number, and Insert Date are buttons on the __________.
CTRL+SHIFT+PLUS sign is the shortcut key for the __________ character formatting task.

CTRL+E is the shortcut key for the __________ paragraph formatting task.

Paragraph formatting in the previous paragraph is carried forward to the next paragraph each time the __________ key is pressed.

The AutoCorrect feature can __________.

To allow a code to be entered into a document and still leave the AutoCorrect feature on, it is necessary to __________.

The base style for new Word documents is called the __________.

Note text is edited using the __________ at the bottom of the Word window.In normal view, an automatic page break __________.

When __________ is typed, Word's AutoCorrect feature automatically changes it to :).

(tm) is an example of Word's __________.

The __________ is a bibliographical list of works referenced directly in a paper, according to the MLA style.

Word inserts __________ just before the location of the insertion point.

To remove a manual page break, double-click the page break to select it and then press the __________.

The process of following a hyperlink to its destination is __________.

The MLA style of documentation requires that the works cited be listed in __________.

To move text, you first select the text to be moved and then use (the) __________.

To select a __________ with a mouse, move the mouse to the left of text until the mouse pointer changes to a right-pointing block arrow, then triple-click.

The __________ boundary is located where the gray meets the white in print layout view.

The amount of vertical space between lines of text in a document is __________.

A(n) __________ is text printed at the top of each page in a document and a(n) __________ is text printed at the bottom of each page in a document.

To __________, or attach, a floating toolbar below the Standard and Formatting toolbars, double-click the floating toolbar's title bar.

Word automatically switches to __________ when the Header and Footer command on the View menu is clicked.

To save typing, the ENTER key could be pressed while the __________ displays, which instructs Word to place that text at the location of the typing.

It is sometimes more efficient to use __________, or keyboard key combinations to format text as it is typed.

CTRL+M is a shortcut key for formatting __________.

The bottom triangle on the horizontal ruler, called the __________, is used to change the entire left margin.

Word provides a(n) __________ feature, which immediately fixes typing, spelling, capitalization, or grammar errors as they are typed into a document.

Superscripts are used to signal an explanatory comment that exists at the end of a document, called a(n) __________, or at the bottom of the page as a(n) __________.

Word automatically numbers notes sequentially by placing a(n) __________ in the body of the document and in front of the note text.

A customized format that can be applied to text is referred to as a(n) __________.

As typed documents exceed one page, Word inserts __________ when it determines the text has filled one page according to paper size, margin settings, line spacing, and other settings.

Because page recomputation is performed between keystrokes, Word refers to the automatic page break task as __________.

__________ are created when the last line of a paragraph displays by itself at the top of a page.

__________ are created when the first line of a paragraph displays by itself at the bottom of a page.
A manual page break also is called a(n) __________.

A(n) __________ is a type of paragraph formatting in which the first line extends to the left of the rest of the paragraph.

The __________ is the bottom triangle at the 0" mark on the ruler.

A(n) __________ is a shortcut that allows you to jump to other documents, objects, or pages.

With Word, paragraphs can be arranged in alphabetic, numeric, or date order based on the first character in each paragraph, in a manner called __________.

When sorting, Word, by default, arranges paragraphs in __________, which means from the beginning of the alphabet, lowest number, or earliest date.

To bring a specific portion of a document into view, click the __________ on the vertical scroll bar.

The temporary storage area for placing text that has been selected and removed from a document is the __________.

The Thesaurus command appears on the __________ submenu on the Tools menu.

When you point to a(n) __________ in a Word document, the mouse pointer shape changes to a pointing hand.

To __________ a document as an attachment, click File on the menu bar, point to Send To, and then click 

